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1. Related Manuals 
 
To ensure system safety, make sure to always read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device which is 
used in the system.  
The table below lists the manuals provided by HMS Industrial Networks AB (hereinafter 
referred to as "HMS") and OMRON Corporation (hereinafter referred to as "OMRON"), which 
pertain to this guide. 
 

Manufacturer Cat. No.  Model Manual name 

OMRON W500 NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

NJ-series CPU Unit  
Hardware User's Manual 

OMRON W535 NX701-□□□□ NX-series CPU Unit  
Hardware User's Manual 

OMRON W593 NX102-□□□□ NX-series  
NX102 CPU Unit  
Hardware User's Manual 

OMRON W578 NX1P2-□□□□ NX-series NX1P2 CPU Unit  
Hardware User's Manual 

OMRON W501 NX701-□□□□ 
NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

NJ/NX-series CPU Unit  
Software User's Manual 

OMRON W505 NJ/NX-series  
CPU Unit Built-in EtherCAT® Port 
User's Manual 

OMRON W504 SYSMAC-SE2□□□ Sysmac Studio Version 1  
Operation Manual  

HMS HMSI-168-95 AB7061 User Manual  
Anybus® CommunicatorTM 

for EtherCAT® 

HMS SP0991 AB7061 Anybus Communicator - EtherCAT 
Interface Installation Sheet 
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2. Terms and Definitions 
 
The terms and definitions used in this guide are given below.  
 

Term Explanation and Definition 

PDO communications 
(communications using 
process data objects) 

PDO communications is used for constant data exchange 
between a master and slaves. PDO data (i.e., I/O data that is 
mapped to PDOs) that is allocated in advance is input and 
output each EtherCAT process data communications cycle (i.e., 
the task period of primary periodic task). The NJ/NX-series 
Machine Automation Controllers use PDO communications for 
commands to refresh I/O data in a fixed control period, 
including I/O data for slave units and the position control data 
for servomotors. It is accessed from NJ/NX-series Machine 
Automation Controllers in the following ways. 

- With device variables for EtherCAT slave I/O 
- With axis variables for a servo drive and an encoder input  
  slave to which an axis is assigned  

SDO communications 
(communications using 
service data objects) 

SDO communications is used to read and write specified slave 
data from a master when required. The NJ/NX-series Machine 
Automation Controllers use SDO communications for 
commands to read and write data, such as for parameter 
transfers, at specified times. The NJ/NX-series Machine 
Automation Controllers can read/write the specified slave data 
(parameters and error information, etc.) with the 
EC_CoESDORead (Read CoE SDO) instruction or the 
EC_CoESDOWrite (Write CoE SDO) instruction.  

slave unit A generic name for a device that performs EtherCAT 
communications with an EtherCAT master. There are various 
types of slave units such as servo drives that handle position 
data and I/O terminals that handle bit signals.  

node address An address to identify a slave unit connected to EtherCAT.  

ESI file 
(EtherCAT slave information 
file) 

It contains information unique to EtherCAT slave units in XML 
format. The ESI file can be loaded into Sysmac Studio, to 
allocate EtherCAT slave process data and make other settings.  
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3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing a safety 
circuit, in order to ensure safety and minimize the risk of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and follow the information provided in 
all Safety Precautions and Precautions for Safe Use in the manuals for each device 
which is used in the system. 

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this guide 
without the permission of OMRON Corporation.  

(5) The information contained in this guide is current as of February 2020. It is subject to 
change for improvement without notice.  

 
The following notations are used in this guide.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally, there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or property damage. 

 
 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 

Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in the text. 
This example shows a general precaution for something that you must do. 
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4. Overview 
 
This guide describes procedures for connecting an HMS Anybus Communicator for EtherCAT 
(hereinafter referred to as the "Communicator") to an OMRON NJ/NX-series Machine 
Automation Controller (hereinafter referred to as the "Controller") via EtherCAT and for 
checking their communication status. 
Refer to Section 6. EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 
understand setting methods and key points to perform PDO communications via EtherCAT.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 

Manufacturer Name Model 

OMRON NJ/NX-series CPU Unit NX701-□□□□ 
NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

HMS Anybus Communicator for EtherCAT AB7061 
 
 

 Precautions for Correct Use 

In this guide, the devices with models and versions listed in 5.2. Device Configuration are 
used as examples of applicable devices to describe the procedures for connecting the 
devices and checking their connection. You cannot use devices with versions lower than 
those listed in 5.2. To use the above devices with models not listed in 5.2. or versions higher 
than those listed in 5.2., check the differences in the specifications by referring to the 
manuals before operating the devices.  

 

 
Additional Information 

This guide describes the procedures for establishing the network connection.  
It does not provide information on operation, installation, wiring method, device functionality, 
or device operation, which is not related to the connection procedures.  
Refer to the manuals or contact the manufacturers of the applicable devices.  
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5.2. Device Configuration 
The hardware components to reproduce the connection procedures in this guide are as 
follows:  

 
 

Manufacturer Name Model Version 
OMRON NX-series CPU Unit  

(Built-in EtherCAT port) 
NX102-1200 Ver.1.40 

－ Power supply (24 VDC for Controller) －  
OMRON Sysmac Studio SYSMAC-SE2□□□ Ver.1.29 
－ Personal computer (OS: Windows 10) －  
－ LAN cable  

(STP (shielded, twisted-pair) cable of  
 Ethernet category 5 or higher) 

－  

OMRON Ethernet cable  
(with industrial Ethernet connector) 

XS5W-T421-□M□-K  

HMS Anybus Communicator for EtherCAT AB7061-C Ver.3.03 
HMS Configuration cable (supplied with Communicator)  
HMS ESI file ABC_ETHERCAT_V_3_03C_ 

pdoupload_for_omron.xml 
 

HMS Anybus Configuration Manager -
Communicator RS232/422/485 

－ Ver.4.5.1.0 

－ Power supply  
(24 VDC for Communicator) 

－  

 

 Precautions for Correct Use 

Contact HMS Industrial Networks AB to obtain the ESI file specified above before 
proceeding.  

 

 Precautions for Correct Use 

The connection line of EtherCAT communications cannot be shared with other Ethernet 
networks. Do not use devices for Ethernet such as an Ethernet switch. Use an Ethernet 
cable (double shielding with aluminum tape and braiding) of Category 5 or higher, and use a 
shielded connector of Category 5 or higher.  
Connect the cable shield to the connector hood at both ends of the cable.  

  

Personal computer  
(Sysmac Studio and  
Anybus Configuration Manager - 
Communicator RS232/422/485 installed, 
OS: Windows 10) 
 

NX102-1200 
(Built-in EtherCAT port) 

Communicator 

Power supply 

LAN cable 
Ethernet cable 

Configuration cable 

Power 
supply 
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 Precautions for Correct Use 

Update Sysmac Studio to the version 1.29 or to a higher version.  
If you use a version higher than the one specified, the procedures and related screenshots 
described in Section 7. and the subsequent sections may not be applicable.  
In that case, use the equivalent procedures described in this guide by referring to the 
Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

 Additional Information 

For information on the specifications of Ethernet cables and network wiring, refer to Section 
4. EtherCAT Network Wiring of the NJ/NX-series CPU Unit Built-in EtherCAT® Port User's 
Manual (Cat. No. W505).  

 

 Additional Information 

For information on the power supply specifications of the Controller, refer to the NX-series 
NX102 CPU Unit Hardware User's Manual (Cat. No. W593).  

 

 Additional Information 

For information on the power supply specifications of the Communicator, refer to the User 
Manual Anybus® CommunicatorTM for EtherCAT® (HMSI-168-95).  
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6. EtherCAT Settings 
 
This section describes the parameters and device variables that are all defined in this guide.  
The Communicator is hereinafter referred to as the "slave unit" in some descriptions.  
 

 Precautions for Correct Use 

This guide describes the EtherCAT communication status check between the Controller and 
the Communicator. The parameters relating to the sub-network are therefore set only for the 
EtherCAT communication status check.  

 
6.1. Parameters 

The following parameters of the Communicator are required to connect to the Controller via 
EtherCAT. 
 

Communicator parameter settings 
Setting item Setting value Remarks 

Node address 1 With Sysmac Studio 

Fieldbus Type EtherCAT ― 

IO Sizes Automatic Default 

Protocol Mode Generic Data Mode ― 

Producer  
Maximum Data length 32 bytes Maximum 512 bytes can be set 

Consumer  
Maximum Data length 32 bytes Maximum 512 bytes can be set 

 

 Additional Information 

Refer to the User Manual Anybus® CommunicatorTM for EtherCAT® (HMSI-168-95) for more 
information on parameters relating to the EtherCAT network and sub-network. 
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6.2. Device Variables 
The process data of the Communicator is assigned to the Controller's device variables.  
The device variable names and data types are shown below.  
 

Output area (Controller to Communicator) 
Device variable name Data type Description 

E001_Outputs_Entry_2100_01 BYTE 

Output data to the Communicator 

E001_Outputs_Entry_2100_02 BYTE 
E001_Outputs_Entry_2100_03 BYTE 
E001_Outputs_Entry_2100_04 BYTE 
E001_Outputs_Entry_2100_05 BYTE 
E001_Outputs_Entry_2100_06 BYTE 
E001_Outputs_Entry_2100_07 BYTE 
E001_Outputs_Entry_2100_08 BYTE 
E001_Outputs_Entry_2100_09 BYTE 
E001_Outputs_Entry_2100_0A BYTE 
E001_Outputs_Entry_2100_0B BYTE 
E001_Outputs_Entry_2100_0C BYTE 
E001_Outputs_Entry_2100_0D BYTE 
E001_Outputs_Entry_2100_0E BYTE 
E001_Outputs_Entry_2100_0F BYTE 
E001_Outputs_Entry_2100_10 BYTE 
E001_Outputs_Entry_2100_11 BYTE 
E001_Outputs_Entry_2100_12 BYTE 
E001_Outputs_Entry_2100_13 BYTE 
E001_Outputs_Entry_2100_14 BYTE 
E001_Outputs_Entry_2100_15 BYTE 
E001_Outputs_Entry_2100_16 BYTE 
E001_Outputs_Entry_2100_17 BYTE 
E001_Outputs_Entry_2100_18 BYTE 
E001_Outputs_Entry_2100_19 BYTE 
E001_Outputs_Entry_2100_1A BYTE 
E001_Outputs_Entry_2100_1B BYTE 
E001_Outputs_Entry_2100_1C BYTE 
E001_Outputs_Entry_2100_1D BYTE 
E001_Outputs_Entry_2100_1E BYTE 
E001_Outputs_Entry_2100_1F BYTE 
E001_Outputs_Entry_2100_20 BYTE 
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Input area (Communicator to Controller) 
Device variable name Data type Description 

E001_Inputs_Entry_2000_01 BYTE 

Input data from Communicator 

E001_Inputs_Entry_2000_02 BYTE 
E001_Inputs_Entry_2000_03 BYTE 
E001_Inputs_Entry_2000_04 BYTE 
E001_Inputs_Entry_2000_05 BYTE 
E001_Inputs_Entry_2000_06 BYTE 
E001_Inputs_Entry_2000_07 BYTE 
E001_Inputs_Entry_2000_08 BYTE 
E001_Inputs_Entry_2000_09 BYTE 
E001_Inputs_Entry_2000_0A BYTE 
E001_Inputs_Entry_2000_0B BYTE 
E001_Inputs_Entry_2000_0C BYTE 
E001_Inputs_Entry_2000_0D BYTE 
E001_Inputs_Entry_2000_0E BYTE 
E001_Inputs_Entry_2000_0F BYTE 
E001_Inputs_Entry_2000_10 BYTE 
E001_Inputs_Entry_2000_11 BYTE 
E001_Inputs_Entry_2000_12 BYTE 
E001_Inputs_Entry_2000_13 BYTE 
E001_Inputs_Entry_2000_14 BYTE 
E001_Inputs_Entry_2000_15 BYTE 
E001_Inputs_Entry_2000_16 BYTE 
E001_Inputs_Entry_2000_17 BYTE 
E001_Inputs_Entry_2000_18 BYTE 
E001_Inputs_Entry_2000_19 BYTE 
E001_Inputs_Entry_2000_1A BYTE 
E001_Inputs_Entry_2000_1B BYTE 
E001_Inputs_Entry_2000_1C BYTE 
E001_Inputs_Entry_2000_1D BYTE 
E001_Inputs_Entry_2000_1E BYTE 
E001_Inputs_Entry_2000_1F BYTE 
E001_Inputs_Entry_2000_20 BYTE 

 

 Additional Information 
For more information on the input and output areas, refer to 3. CANopen Object Dictionary 
Implementation of the User Manual Anybus® CommunicatorTM for EtherCAT® (HMSI-168-95). 

 

 Additional Information 

The device variables are automatically named with a combination of the device names and the 
port names. The default device names are "E" followed by a serial number starting from "001".  
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7. EtherCAT Connection Procedure 
 
This section describes the procedures for connecting the Controller and the Communicator via 
EtherCAT. The procedure for setting up the Controller in this guide is based on the factory 
default settings. Refer to Section 8. Initialization Method for information on initialization.  
 

7.1. Work Flow 
Take the following steps to connect the Controller and the Communicator via EtherCAT and 
perform PDO communications.  

 
7.2. HMS Communicator Setup  Set up the HMS Communicator. 

↓   

 7.2.1. Hardware Settings  Connect the cables to the Communicator. 

↓   

 7.2.2 Parameter Settings  Set parameters for the Communicator. 

↓   

7.3. Controller Setup  Set up the Controller.  

↓   

 7.3.1. Starting Sysmac Studio and 
Installing the ESI File  

 Start Sysmac Studio and install the ESI file for the 
Communicator. 

↓   

 7.3.2. Setting the EtherCAT Network 
Configuration 

 Set the EtherCAT network configuration.  

↓   

 7.3.3. PDO Map Settings  Match the PDO mapping list and PDO entry list of 
the Communicator.  

↓   

 7.3.4. Setting Device Variables  Set device variables to use for PDO 
communications with the Communicator. 

↓   

 7.3.5. Transferring the Project Data  Transfer the project data created in Sysmac 
Studio to the Controller.  

↓   

7.4. EtherCAT Communication Status 
Check  

 Confirm that PDO communications via EtherCAT 
is performed normally.  

↓   

 7.4.1. Checking the Connection 
Status 

 Check the EtherCAT connection status.  
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7.2. HMS Communicator Setup 
Set up the HMS Communicator. 
 

7.2.1. Hardware Settings 
Connect the cables to the Communicator. 
 

 Precautions for Correct Use 

Make sure the power supply is OFF before setting up. If it is ON, the settings described in 
the following steps and subsequent procedures may not be applicable.  

 

1 Make sure Power supply for 
Communicator is OFF. 

 

2 Check the position of 
connectors on Communicator 
by referring to the figure on the 
right. 

 

3 Connect an Ethernet cable to 
EtherCAT Port 1 (In). 

 

Ethernet cable 

EtherCAT Port 1 (In) 
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4 Connect Power supply for 
Communicator to Power 
Connector. 
 
*For information on the power 
supply connection to 
Communicator, refer to the 
User Manual Anybus® 
CommunicatorTM for 
EtherCAT® (HMSI-168-95) or 
the Anybus Communicator - 
EtherCAT Interface Installation 
Sheet (SP0991).   

  

Power supply 
Power Connector 
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7.2.2. Parameter Settings 
Set parameters for the Communicator. 
The software tool "Anybus Configuration Manager - Communicator RS232/422/485" 
(hereinafter called "ACM") is used to set parameters.  
Install the software tool on your computer before proceeding.   
 

 Additional Information 

For information on how to install ACM, refer to the User Manual Anybus® CommunicatorTM 
for EtherCAT® (HMSI-168-95). 

 

1 Connect the Configuration cable 
between Personal computer 
and PC-connector located at the 
bottom of Communicator. 
 
*For information on the 
connection between 
Communicator and Personal 
computer, refer to the User 
Manual Anybus® 
CommunicatorTM for 
EtherCAT® (HMSI-168-95) or 
the Anybus Communicator - 
EtherCAT Interface Installation 
Sheet (SP0991).  

 

2 Turn ON Communicator.  

3 Start ACM on Personal 
computer.  

 

4 ACM starts up.  
The Select Configuration Dialog 
Box appears. 

 

Configuration cable 

PC-connector 

Personal computer 
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5 In the Select Configuration 
Dialog Box, select Blank 
Configuration and click OK. 

 

6 Select Communicator 
RS232/422/485 displayed on 
the left side of the main window. 

 

7 Parameters of Communicator 
RS232/422/485 appear on the 
right side of the main window. 

 

8 On the Categorized Tab Page 
(default display), select Generic 
Data Mode from the pull-down 
list in the Protocol Mode Field 
under Protocol.  
 
 
 
 
 
Check that Protocol Mode is set 
to Generic Data Mode. 
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9 Click Fieldbus on the left side 
of the main window. 

 

10 Parameters of Fieldbus appear 
on the right side of the main 
window. 

 

11 In the same way as step 8, 
select EtherCAT from the pull-
down list in the Fieldbus Type 
Field under Fieldbus. 

 
 

 

12 Select Automatic from the pull-
down list in the IO Sizes Field 
under IO Sizes. 

 

13 Click the + Button of 
Subnetwork on the left side of 
the main window to expand it. 
 
New Node is displayed.  
Right-click New Node and 
select Add Transaction 
Produce from the menu. 
 
Check that Produce 1 is added 
under New Node. 
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14 Right-click Produce 1 and 
select Add Variable Data from 
the menu. 
 
 
 
 
 
 
 
Check that VariableDataObject 
is added under Produce 1. 

 
 

 

15 Parameters of 
VariableDataObject (under 
Produce 1) appear on the right 
side of the main window.  
Enter 0x0020 (32 bytes) in the 
Maximum Data length Field. 

 

16 In the same way as step 13, 
right-click New Node and select 
Add Transaction Consume 
from the menu. 
 
 
 
 
Check that Consume 1 is added 
under New Node.  
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17 In the same way as step 14, 
right-click Consume 1 and 
select Add Variable Data from 
the menu. 
 
 
 
 
 
 
 
Check that VariableDataObject 
is added under Consume 1.  

 
 

 

18 Parameters of 
VariableDataObject (under 
Consume 1) appear on the right 
side of the main window.  
Enter 0x0020 (32 bytes) in the 
Maximum Data length Field. 

 

19 Select Communicator 
RS232/422/485 on the left side 
of the main window. 
 
On menu bar, the second menu 
from the left changes from  
VariableDataObject to  
Communicator RS232/422/485.   

20 Select Connect from the 
Communicator RS232/422/485 
Menu. 

 

21 Check that the Config Line LED 
on the lower right side of the 
main window turns green.  
 
*It indicates that ACM is online 
with Communicator. 
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22 Select Download 
configuration to 
Communicator RS232/422/485 
from the Tools Menu. 

 

23 The Name the Configuration 
Dialog Box appears.  
Check the message and click 
OK. 
 
 
 
 
 
 
 
The Download Dialog Box 
appears and shows the 
progress of the download.  
The dialog box closes after the 
download is completed. 

 

 

 

24 In the same way as step 19, 
select Disconnect from the 
Communicator RS232/422/485 
Menu while selecting 
Communicator RS232/422/485 
on the left side of the main 
window. 

 

25 Check that the Config Line LED 
on the lower right side of the 
main window turns red. 
 
*It indicates that ACM is offline 
with Communicator. 

 

26 Turn OFF Communicator.   

27 Remove the Configuration cable 
that is connected between 
Personal computer and 
Communicator. 
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7.3. Controller Setup 
Set up the Controller.  
 

7.3.1. Starting Sysmac Studio and Installing the ESI File 
Start Sysmac Studio and install the ESI file for the Communicator.  
 

1 Make sure Power supply for 
Controller and Communicator 
are powered OFF. 

 

2 Connect Personal computer and 
Built-in EtherNet/IP port 
(PORT1) on Controller with a 
LAN cable.  
Connect the other end of the 
Ethernet cable (which at one 
end has been connected to 
Communicator) to Built-in 
EtherCAT port (PORT3) on 
Controller.  
Connect Power supply to 
Controller.  
 
*For information on the power 
supply connection to 
Controller, refer to 5-4-1 Wiring 
the Unit Power Supply of the 
NX-series NX102 CPU Unit 
Hardware User's Manual (Cat. 
No. W593).  

 

3 Turn ON Controller and 
Communicator. 

 

4 Start Sysmac Studio.  
 
*If the User Account Control 
Dialog Box appears at start, 
make a selection to start 
Sysmac Studio.  

 

Controller  

LAN cable 

Built-in EtherCAT port 
(PORT3) 

Ethernet cable 

Built-in EtherNet/IP port 
(PORT1) 

Communicator 

Personal  
computer 

Power  
supply 



7．EtherCAT Connection Procedure 

 21 

5 Sysmac Studio starts up.  
Click New Project. 

 

6 The Project Properties Screen 
appears. Select items 
appropriate for your Controller 
from the pull-down list in each 
field of Select Device.  
Click Create.  
 
The following Controller is used 
in this guide.  
・Category: Controller 
・Device: NX102-1200 
・Version: 1.40 

 
*In this guide, "New Project" is 
used as the project name.  

 

7 The New Project Window 
appears.  
 
The following panes are 
displayed in the window.  
Left: Multiview Explorer 

Upper right: Toolbox 

Lower right: Controller Status Pane 

Upper middle: Edit Pane 

The following tabs are displayed 
in the lower middle of the 
window.  
Output Tab Page  

Build Tab Page 

 

8 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer.  

 

Controller 
Status 
Pane 

Build Tab 
Page 

Output Tab 
Page  

Multiview 
Explorer Edit Pane 

Toolbox 
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9 The EtherCAT Tab Page 
appears in the Edit Pane.  

 

10 Right-click Master and select 
Display ESI Library from the 
menu.  

 

11 The ESI Library Dialog Box 
appears.  
Click Install (File).  

 

12 The Open Dialog Box appears. 
Select the prepared ESI file 
ABC_ETHERCAT_V_3_03C_ 
pdoupload_for_omron.xml and 
click Open.  

 

13 The dialog box on the right 
appears. Check the message 
and click Yes.  
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14 The dialog box on the right 
appears when the ESI file 
installation is completed.  
Check the message and click 
OK.   

15 Click the + Button of 
ABC_ETHERCAT_V_3_03C_ 
pdoupload_for_omron in the 
ESI Library Dialog Box, and 
check that Anybus 
Communicator - Slave 
Rev:0x00030003 (Anybus 
Communicator - Slave) is 
displayed. 
 
Check that there are no 
exclamation marks (errors).  
 
Click Close. 

 

 

 

 Precautions for Correct Use 

If an exclamation mark (error) appears for the ESI file, check the name of the ESI file and 
obtain the ESI file with a correct name. If an exclamation mark (error) still appears even 
when the name of the ESI file is correct, the file may be corrupted.  
In that case, contact HMS Industrial Networks AB.  
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7.3.2. Setting the EtherCAT Network Configuration 
Set the EtherCAT network configuration.  

 

 

The slave unit may perform unexpected operation after you power cycle it in 
step 10. Always confirm safety before you power cycle the slave unit.  

 

 

1 Select Communications Setup 
from the Controller Menu.  

 

2 The Communications Setup 
Dialog Box appears.  
Select Direct connection via 
Ethernet in the Connection type 
Field. Click OK.  

 

3 Select Online from the 
Controller Menu.  
 
 
 
 
*If the dialog box on the right 
appears, check the message 
and click OK, then, after 
checking that Controller has 
restarted, select Online again.  

 
 
*If the dialog box on the right 
appears, check the message 
and click Yes. 

 
*The message of the dialog box 
varies with the status of 
Controller. Check the message 
and click on an appropriate 
button to proceed with the 
processing. 
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4 When an online connection is 
established, a yellow line 
appears under the toolbar.  

 

 

 Additional Information 

For information on online connections, refer to Section 6. Online Connections to a Controller 
of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

5 Right-click Master on the 
EtherCAT Tab Page displayed in 
the Edit Pane, and select Write 
Slave Node Address from the 
menu.  
 
*If the EtherCAT Tab Page is not 
displayed in the Edit Pane, 
follow step 8 of 7.3.1. Starting 
Sysmac Studio and Installing 
the ESI File to display the tab 
page.  

 
 
 
A dialog box appears stating 
"Get information is being 
executed". 

 
 

 

6 The Slave Node Address 
Writing Dialog Box appears.  
Anybus Communicator - Slave 
Rev:0x00030003 is displayed in 
the Actual network 
configuration. 

 

7 Enter 1 (node address) in the 
Set value Column.  

 

8 Check that no errors appear 
and that the set value is 1.  
Click Write.  
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9 The Slave Node Address 
Writing Dialog Box appears. 
Check the message and click 
Write.  
 
A dialog box appears stating 
"Slave Node Address Writing is 
being executed". 
 
The dialog box on the right 
appears after the node address 
is successfully written to the 
slave unit. Check the message 
and click Close.  

 
 

 
 

 

10 Power cycle Communicator.  

11 Right-click Master on the 
EtherCAT Tab Page displayed in 
the Edit Pane, and select 
Compare and Merge with 
Actual Network Configuration 
from the menu.  
 
 
 
 
 
 
 
 
A dialog box appears stating 
"Get information is being 
executed". 

 
 

 

12 The Compare and Merge with 
Actual Network Configuration 
Dialog Box appears.  
After the comparison, Anybus 
Communicator - Slave 
Rev:0x00030003 is addressed 
as node 1 and is added to the 
Actual network configuration. 
 
Click Apply actual network 
configuration.  
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13 A confirmation dialog box 
appears. Check the message 
and click Apply.  
 
A result dialog box appears. 
Check the message and click 
Close.  

 
 

 

14 E001 Anybus Communicator - 
Slave Rev:0x00030003 is 
addressed as node 1 and is 
added to the Network 
configuration on Sysmac Studio. 
 
Check that the data is added. 
Click Close.  

 

 
 

 
 

15 E001 Anybus Communicator - 
Slave Rev:0x00030003 is 
addressed as node 1 and is 
added to the EtherCAT Tab 
Page displayed in the Edit 
Pane. 
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7.3.3. PDO Map Settings 
Match the PDO mapping list and PDO entry list of the Communicator.  

 

1 On the EtherCAT Tab Page 
displayed in the Edit Pane, 
select Communicator with node 
address 1, and click Edit PDO 
Map Settings in the PDO Map 
Settings Field.  

 

2 The Edit PDO Map Settings 
Dialog Box appears.  
Click Apply actual device.  

 

3 The PDO mapping data is 
updated, which corresponds to 
the process data size of the 
slave unit.  
 
Check that the following 
process data size is displayed.  

Input 256 [bit] (32 bytes) 
Output 256 [bit] (32 bytes) 
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4 Select the following PDO 
mapping, and check that the 
total size of all PDO entries 
included in the PDO mapping is 
32 bytes.  
 
・Selection:  
・Input/Output: Output 
・Name: Outputs 

 

5 Select the following PDO 
mapping, and check that the 
total size of all PDO entries 
included in the PDO mapping is 
32 bytes.  
 
・Selection:  
・Input/Output: Input 
・Name: Inputs 
 
Click OK. 

 

6 The set PDO mapping data is 
displayed in the PDO Map 
Settings Field.  
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7.3.4. Setting Device Variables 
Set device variables to use for PDO communications with the Communicator. 

 

1 Select Offline from the 
Controller Menu.  
 
 
 
 
The yellow line under the 
toolbar disappears.  

 
 

 

2 On the EtherCAT Tab Page 
displayed in the Edit Pane, 
select Communicator with node 
address 1, and check that the 
device name is E001. 
 
*The device name can be 
changed as desired.  

 

3 Double-click I/O Map under 
Configurations and Setup in 
the Multiview Explorer.  

 

4 The I/O Map Tab Page appears 
in the Edit Pane.  
Check that Node1 is displayed 
in the Position Column and that 
the added Communicator is 
displayed in the Port Column.   
 
*In next step, the device 
variables are automatically 
named for the I/O ports of the 
slave unit.  

 To manually create variable 
names for I/O ports, click a cell 
in the Variable Column for a 
target port and enter a variable 
name.  
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5 Right-click Node1 and select 
Create Device Variable from 
the menu.  

 

6 The variable names and types 
are set.  

 

 

 Additional Information 

The device variables are automatically named with a combination of the device names and 
the port names.  
The default device names are "E" followed by a serial number starting from "001".  

 

 Additional Information 

In this guide, device variables are automatically named for each unit (each slave).  
They can also be manually named for each port.  
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7.3.5. Transferring the Project Data  
Transfer the project data created in Sysmac Studio to the Controller.  
 

 
Regardless of the operating mode of the CPU Unit, devices or machines may 
perform unexpected operation when you transfer any of the following data from 
Sysmac Studio: a user program, configuration data, setup data or device 
variables. Always confirm safety at the destination node before you transfer the 
project data.  

 

 

 

Before you transfer the parameters, check the specifications of the EtherCAT 
slave unit in manuals or other documentation and confirm that the system will 
not be adversely affected.  

 

 

 
After you transfer the project data, the CPU Unit restarts, and communications 
with the slave unit is cut off. During the period, the outputs of the slave unit 
behave according to the slave unit settings. The time that communications is 
cut off depends on the EtherCAT network configuration. Before you transfer the 
project data, confirm that the slave unit settings will not adversely affect the 
system.   

 

 
 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page appears.  
Check that "0 Errors" and "0 
Warnings" are displayed.  

 

3 Select Rebuild Controller from 
the Project Menu.  
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4 The dialog box on the right 
appears. Confirm that there is 
no problem, and click Yes.  

 

5 Check that "0 Errors" and "0 
Warnings" are displayed on the 
Build Tab Page.  

 

6 Select Online from the 
Controller Menu.  
 
 
When an online connection is 
established, a yellow line 
appears under the toolbar.  

 
 

 

7 Select Synchronize from the 
Controller Menu.  

 

8 The Synchronization Dialog Box 
appears.  
Check that the data to be 
transferred (e.g. NX102) is 
selected.  
Click Transfer To Controller. 
 
*After you click on the button, 
the Sysmac Studio data will be 
transferred to Controller, and 
the data will be synchronized.   
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9 The dialog box on the right 
appears. Confirm that there is 
no problem, and click Yes.  
 
 
A message appears stating 
"Synchronizing". 
 
 
 
The dialog box on the right 
appears. Confirm that there is 
no problem, and click No. 
 
*Do not return to RUN mode.  

 
 

 
 

 

10 As shown in the figure on the 
right, the font color that is used 
to display the synchronized data 
changes to the same color as 
the one used to specify 
"Synchronized". Check that a 
message appears stating "The 
Synchronization process 
successfully finished". 
Confirm that there is no 
problem, and click Close.  
 
*When the project data created 
in Sysmac Studio matches the 
Controller data, a message 
appears stating "The 
Synchronization process 
successfully finished". 

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  

 

  



7．EtherCAT Connection Procedure 

 35 

7.4. EtherCAT Communication Status Check 
Confirm that PDO communications via EtherCAT is performed normally.  
 

7.4.1. Checking the Connection Status 
Check the EtherCAT connection status.  
 

1 Check with the LED indicators 
on Controller that PDO 
communications via EtherCAT is 
performed normally.  
 
The LED indicators in normal 
status are as follows:  

NET RUN: Green lit 
NET ERR:  Not lit 
LINK/ACT:  Yellow flashing  

 
*The NJ-series Controllers also 
have the same LED indicator 
status.  

 
 
 
 

  

2 Check the LED indicators on 
Communicator. 
 
The LED indicators in normal 
status are as follows:  

1 RUN: Green lit 
2 ERR: Not lit 
3 Link/Activity 1:  
       Green, flickering 
4 Link/Activity 2: Not lit 
5 Subnet status: Red lit 
6 Device status:   
       Green flashing 

 
*In this guide, the LED “5 
Subnet status” is lit red as no 
connection is made via the 
sub-network. This LED status 
does not affect EtherCAT 
communications. 

 

3 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer.  

 

Built-in EtherCAT (Port 3)  
Status Indicators 
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4 On the EtherCAT Tab Page 
displayed in the Edit Pane, 
check that the ▶ mark appears 
on the icon of Communicator. 

( )  

 
*It indicates that EtherCAT 
communications is performed 
normally. 

 

5 Select Troubleshooting from 
the Tools Menu.  

 

6 The Troubleshooting Dialog Box 
appears.  
 
Check that "No Error" is 
displayed in the Details Field on 
the Controller Errors Tab Page.  
 
*The tab page reports "No 
Error" when there are no errors 
in EtherCAT communications.   
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8. Initialization Method 
 
The setting procedures in this guide are based on the factory default settings.  
Some settings may not be applicable unless you use the devices with the factory default 
settings.  
 

8.1. Initializing a Controller 
To initialize a Controller, clear all memory of a CPU Unit.  
With Sysmac Studio, change the operating mode of Controller to PROGRAM mode and select 
Clear All Memory from the Controller Menu. The Clear All Memory Dialog Box appears. 
Check the message and click OK.  
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9. Revision History 
 

Revision 
code Date of revision Description of revision 

01  August 2013 First edition 

02 March 2014 Correction of device variable names for input area  
Correction of erroneous description 

03 September 2014 Changed some descriptions along with upgrading the NJ/NX-
series Controllers, Sysmac Studio, Communicator and Anybus 
Configuration Manager.  
Changed the ESI file along with upgrading the Communicator.  
The procedure of "7.2. Setting Up HMS Communicator" is 
divided into "7.2.1. Hardware Settings “ and "7.2.2. Parameter 
Settings ". 

04 March 2020 Changed some descriptions along with upgrading the NJ/NX-
series Controllers and Sysmac Studio.  

   
 
 



2013-2020

0320(0813) P560-E1-04


	1. Related Manuals
	2. Terms and Definitions
	3. Precautions
	4. Overview
	5. Applicable Devices and Device Configuration
	5.1. Applicable Devices
	5.2. Device Configuration

	6. EtherCAT Settings
	6.1. Parameters
	6.2. Device Variables

	7. EtherCAT Connection Procedure
	7.1. Work Flow
	7.2. HMS Communicator Setup
	7.2.1. Hardware Settings
	7.2.2. Parameter Settings

	7.3. Controller Setup
	7.3.1. Starting Sysmac Studio and Installing the ESI File
	7.3.2. Setting the EtherCAT Network Configuration
	7.3.3. PDO Map Settings
	7.3.4. Setting Device Variables
	7.3.5. Transferring the Project Data

	7.4. EtherCAT Communication Status Check
	7.4.1. Checking the Connection Status


	8. Initialization Method
	8.1. Initializing a Controller

	9. Revision History



